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1 Introducing UltraPrint

Alto Imaging Technologies UltraPrint is a powerful...

Advanced print-on-demand management system designed for high-volume document
production. UltraPrint provides a sophisticated, yet cost effective solution capable of driving
single or clustered printers ranging in speed from 40 to 300+ impressions per minute.

Create print jobs from Tagged Image File Format (TIF), Adobe Portable Document Format
(PDF), PostScript (PS),  or Printer Command Language (PCL) files. Advanced image
controls include N-up printing, booklet making, variable text overlay, and other
imposition/layout options.

Use UltraPrint to provide high-speed Raster Image Processing (RIP) services to
monochrome and full-color output devices, and an advanced, direct printing support for the
Kodak/Heidelberg DigiMaster 9110/E125/E150, Kodak 92P/SP, and RPCS driven Ricoh
printers.

UltraPrint Features

· Streamlined document assembly lets you create complex documents made from multiple
files and different formats.

· Add headers, footers, and page numbering, intelligently skipping tabs and alternating
placement for two-sided or tumble output.

· Select from several custom layouts including 2-up, 4-up, booklet, and multi-part forms.

· Automate variable data and sequential number. Includes support for page application
control and sequential numbering, making it easy to create forms and mail merge
applications.

· Supports queue-based for remote job submission. Integrates with Microsoft Internet
Information Services (IIS) to provide cost-effective web-based printing.

· In addition to standard Windows printing, UltraPrint supports native TIFF printing to output
devices based on the Kodak/Heidelberg DigiMaster 9110/E125/E150 printers. Includes
support for page-level media selection, and job-ticketing (templates) recall.
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2 Installing and Configuring

Before you begin, be sure you have:

· A computer that meets the system requirements  for running UltraPrint.

· The UltraPrint installation software. If you have a CD, this installation software is located in
the directory specified in the installation steps. If you obtained the software electronically,
then locate the single installation file you downloaded.

Installing UltraPrint is simple. Here is a summary of the steps it takes to get started:

1. Install the UltraPrint application .

2. Obtain a software activation key and activate the license .

3. Configure AltoScript  support for PostScript (PS) and Portable Document Format
(PDF) files.

4. Configure other options  as desired.

5. Start using UltraPrint!

See Also: Product Activation , Configuring UltraPrint , Custom Print DigiMaster 9110

8
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2.1 System Requirements

What do you need to run UltraPrint? Use the information in the following tables to help you
select a computer and operating system that meets your needs.

UltraPrint Client/Server Requirements

Processor · Intel® Pentium™ 4 E521 2.80-gigahertz (GHz); Intel®
Core™2 Duo processor E6400 or higher
(recommended)

Operating System · Windows® Server 2003, Standard Edition

· Windows Server 2003, Enterprise Edition

· Windows XP Professional (recommended)

· Windows® 2000 Server 

· Windows 2000 Advanced Server 

· Windows 2000 Datacenter Server 

Memory · 1 gigabyte (GB) of RAM; 2 gigabyte (GB) of RAM
recommended

Hard Drive · 7.2K RPM Serial ATA 3Gbps; 10K RPM Serial-Attach
SCSI 3Gbps (recommended)

· 90 to 100 MB of available hard-disk space (program
installation only)

Hard Drive
Controller

· Serial ATA; U320 SCSI (recommended)

Optical Drive · CD-ROM drive; CD-RW or DVD-RW recommended

Display/Monitor · 1024x768 SVGA or higher-resolution monitor with
AGP/PCI Graphics adapter and 128 MB RAM; 19-inch
monitor with 1280x1024 SXGA 4x AGP Graphics
Adapter and 256 MB (DDR) SDRAM(recommended)

Networking · 100/1000 Mbps Ethernet adapter or higher

Other Software and
Devices

· Microsoft Internet Explorer version 5.5 SP1 or later
required

· TWAIN compliant imaging device (Image Arranger server
only)

Notes: Memory requirements are dependent on operating system selection and
other factors and could be higher. Hard disk space requirements do not include
space required for image or document storage.
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2.2 Installing Application

1. Log on to your Microsoft Windows computer as Administrator, or as a user who is a
member of the Administrator group.

2. If you are installing from CD, click the Start button, choose Run and type:

D:\Alto Imaging Arranger\Data\Setup.exe

Where D: is the drive letter for your CD-ROM drive, and then click OK.

 –or–

If you are installing from a downloaded file, click the Start button, choose Run, and
browse to the folder where you saved the program file. Select the program file, click 
Open, and then click OK.

3. When Alto Imaging Technologies UltraPrint Installation Welcome appears, click
Next to begin installation.

4. After reviewing and accepting the end user license agreement (EULA), click Next.

5. Click Next to install UltraPrint in the default program folder.

–or–

To install in a directory other than the default, click Browse and select a folder. If the
folder does not exist, it will be created for you.

6. Click Yes to save copies of any files replaced during the installation process, or click
No to overwrite files without saving, and then click Next.

If you select Yes, you are prompted to choose the folder where you want to save the
files. To save to a folder other than the default, click Browse and select a folder. If the
folder does not exist, it will be created for you.

7. After the required information has been gathered, click Next to begin copying setup
files.

TIP: If you want to make changes, click Back until you find the information
you want to change.

9. Click Finish.

TIP: If you are installing other UltraWare applications, you can perform
these installations prior to restarting the system. After all installations are
complete, the system must be restarted

10. Click OK to restart the system.

Next: Activate your software 10
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2.3 Product Activation

UltraPrint requires hardware specific product activation to validate your software license
prior to enabling use of the application. Each software license issued by Alto Imaging
Technologies is valid for a specific period of time. During this time, you can install updates
as often as they become available. At the end of your license term, UltraPrint will continue to
function, but new updates may not be installed.

IMPORTANT: Applying an update dated after the expiration of your license will
cause UltraPrint to stop working. Verify the expiration date of your current
license prior to installing a newer version by selecting About UltraPrint from
the Help menu.

Activating and Enabling UltraPrint

Follow the steps in the following sections to create a hardware identifier . A hardware
identifier is a small file that contains information about your PC and currently installed
system components. The information in this file is used to obtain a software activation key
that activates UltraPrint only for the PC on which the hardware identifier was created.

Once you receive your key, activate the software license  by simply copying a file you
receive from Alto Imaging Technologies into the UltraKey folder to enable your software.

2.3.1 Creating a Hardware Identifier

1. Click Start, choose Run, and then type:

C:\Program Files\Alto Imaging Common\UltraKey\UKPCID.exe

2. Click OK to launch the UltraKey PC Identifier.

3. Click Go to begin creating the hardware identifier.

 

10
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4. Click Save to create the file using the default filename.

–or–

Choose a new folder, type a new File Name, and then click Open.

5. Click Close.

TIP: Remember where you save the file so you can easily locate it when your
are ready to request activation.

 

Next: Obtain a Software Activation Key

2.3.2 Obtaining a Software Activation Key

1. Use your web browser to access the Software License Request form at:

http://www.altoimaging.com/altoweb/productregistration/keysubmit/keyform.html

2. Type the requested information for each field.

3. Click Browse to locate and attach the hardware identifier file  you created in
previous steps.

4. Click Submit to send the request.

NOTE: Your software activation key will be returned to the email address
you enter on the request form. It can take up to 24 hours to receive your
software activation key

 

Next: Activate the Software License

2.3.3 Activating the Software License

· Copy the activation key  you received to the UltraKey folder. The path to the folder
is:

C:\Program Files\Alto Imaging Common\UltraKey\

2.4 Configuring UltraPrint

Before you begin...
 

· Install the UltraPrint software .

· Get a software license  key from Alto Imaging Technologies. This license must be
installed before your software will be functional.

11
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· Be sure you have physically connected, installed drivers for, and tested your output
device(s).

Configuring UltraPrint takes just a few simple steps.

1. Select Advanced Options  that control how UltraPrint renders print ready files, including
specific settings for PostScript (PS) and  Portable Document Format (PDF) files rendered
using AltoScrip t.

2. Select Viewer and Output options .

3. Select other options as desired.

To configure UltraPrint options

· Click Preferences  on the toolbar.

2.4.1 Viewer and Output Options

When viewing and editing files , most formats are passed directly to the internal viewer
or to the registered application. When UltraScript  or AltoScript  are enabled, page
description language (PDL) formats including HP Printer Command Language (PCL),
PostScript (PS), and Portable Document Format (PDF) files are rendered to a bitmap
imaged which is then passed to the internal viewer or registered application for Tagged
Image File Format (TIFF) images.

15

16
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Viewer Output Options

Specify TIFF options for images created by UltraPrint during the rendering process.

To change viewer output options

1. Click Preferences  on the toolbar.

2. Select the Viewer Output Options tab.

Category Option Description

Viewer (CCITT
Group 4)

Render images compatible with the CCITT Group 4
communication specification.

TIFF
Options

Multiple
Strips per
Image

Create multiple strips per images. Some viewers need
one large strip per page while others can handle
multiple strips.

NOTE: Leave this unchecked unless you are sure your
viewer application can handle multiple strips.

Strip Rows Sets number of strips per image (defaults to 20).
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Output File Options

Specifies the storage location and other options relating to the bitmap images produced by
the rendering engine.

To change output file options

1. Click Preferences  on the toolbar.

2. Select the Output File Options tab.

Option Description

Default
Destination

Directory where image files should be written during the rendering
process. The default is the temporary folder specified by the 
%TEMP% environment variable .

Preserve
Output

Keep intermediate files. Allows images to be viewed or printed
without being rendered on successive operations.

NOTE: This option is required for Custom Print .

Unique
Destination on
New Book

Creates a sub directory in the Default Destination for each. This
forces print ready files used in more than one print job to be
rendered individually, otherwise the same copy is used for viewing
and output for each print job that references a given file.

17
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TIP: To improve performance, create a separate directory for files rendered by
UltraPrint and select the directory as the Default Destination.

To change default destination:

· Click Browse to locate or create the directory where rendered files should be written.

NOTE: You can override the Default Destination by manually selecting a new
Destination for the selected job on the Job Info  tab.

2.4.2 Advanced Options

UltraPrint renders print-ready Printer Control Language (PCL), PostScript (PS), and Portable
Document Format (PDF) files using one of two internal Raster Imager Processor (RIP)
engines. The UltraScript engine processes PCL and PostScript (when AltoScript is not
enabled) files, while the AltoScript  engine renders PostScript and PDF files.

Select and enable available rendering engines and options.

To change advanced options

1. Click Preferences  on the toolbar.

2. Select the Advanced Options tab.

26

16
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Category Option Description

Image
Rendering
Options

Enable
UltraScript

Enables PCL and PostScript rendering.

Enable
AltoScript

Enables PostScript and PDF rendering.

UltraPrint
Web

Enable Ultra
Print Web
Server

Provides web based print submission queuing.

NOTE: Required when using UltraPrintWeb or Alto
Imaging Transaction Server (AITS)

General Default
Resolution

Select 300dpi or 600dpi output. 300dpi results in faster
rendering to the viewer and processing to the selected
print device

Retry
Interval
(sec)

In event communication fails, how often UltraPrint
should attempt to re-establish communication with the
RIP. Defaults to 10.

Retry Count How many times the UltraPrint should attempt to
render the file before the print process fails. Defaults to
30.

AltoScript Options

Advanced AltoScript Options specifies attributes and options that affect the output of
images rendered by the AltoScript engine. 

To select AltoScript options

1. Click the  button next to Enable AltoScript.

2. Select settings for each of the following options:

Option Description

Dither (LPI) Sets the screen used to render halftones
during the import, expressed as
lines-per-inch (lpi).

NOTE: Allowable ranges vary based on the
selected resolution.

Use crop box Defines page size based on the crop box
dimensions embedded in a Portable
Document Format (PDF) file. This is the
default when a PDF file is displayed or
printed using Adobe Acrobat.

NOTE: UltraPrint defines page size based on
media box dimensions by default.

Use CIE Color Remaps device-dependent color values
through a CIE color space. This can can
improve conversion of CMYK documents to
RGB.
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2.4.3 Active Queue Options

UltraPrint includes support for remote and cluster printing. Print jobs can be submitted using
either web-based or driver-based methods. Up to four printers can be attached to an Active
Queue for load-balanced output.

See Queue-based and Cluster Printing  for more information. 

2.4.4 Import Options

UltraPrint imports Raster Document Object (RDO) (DigiPath version 2.x or earlier), Danka
CJB, and GammaGraphX (GGX) files.

See Working with RDO Files  for more information.

GGX Options

To change GGX options

1. Click Preferences  on the toolbar.

2. Select the GGX Options tab.

Option Description

Single Image
Per File

Each page in the is imported as a single image TIFF file

Multi Image
Per File

Pages are merged to create a single, multi-image TIFF

2.4.5 Custom Print DigiMaster 9110

UltraPrint supports a direct printing interface to output devices based on the
Kodak/Heidelberg DigiMaster 9110/E125/E150 printers. Custom Print uses FTP to transfer
images directly to the marking engine, and LPR to send printing instructions to the printing
subsystem control system (SCS). Since UltraPrint sends raw TIFF images to the print
engine, no processing by the RIP is necessary, and printing throughput is maximized.

The interface makes it easy to set up even the most complex print jobs. Point-and-click
selections for paper substitutions, sub-set finishing, and advanced options like cover mode,
separator sheets, non-printing inserts, and page selections shortcuts  make Custom Print a
powerful front end to the DigiMaster Production Printing System.

Job templates  are saved and available for subsequent printing simplifying reprinting.

Setup and Configuration

Before you begin, make sure you have:

· The IP address for the Kodak/Heidelberg DigiMaster 9110/E125/E150 printer

· The superuser login and password for the printer

· An active network connection to the printer

69

74

56
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If you have not previously installed... UltraPrint or Image Arranger and configured
Custom Print DigiMaster for the 9110, complete this step to initialize the Custom Print
settings and create a Default Printer :

1. Click Start, point to All Programs.

2. From the Accessories folder, select Windows Explorer.

3. Browse to open the following folder:

 C:\Program Files\Alto Imaging Common\Templates\9110

4. Right-click the file:

 Default-CP.reg

5. On the context menu click Merge.

6. Click OK to confirm.

WARNING: Repeating this step after configuring Custom Print will re-
initialize all Custom Print settings.

Modifying Printer Settings

To modify printer settings

1. Select a print job.

NOTE: The print job must contain at least one print-ready file.

2. On the File menu, point to Custom Print, and then click Digimaster 9110 Custom
Print.

3. Under Print Settings, click More.

21
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Configuring a Printer

To configure a printer

1. Follow the steps to modify printer settings .

2. Type the following information in each field under Settings.

Field Name Value

Image Path ftp:\\<ip_addr>\var\spool\drop_box\images\

LPR String LPR -S <ip_addr> -P DM9110

Paper Catalog ftp:\\<ip_addr>\var\spool\drop_box\def_media_catalog.mc

Spool Path /var/spool/drop_box/images/

IMPORTANT: Replace <ip_addr> with the IP address or host name assigned to

the printer.

3. Click Login, type the User ID and Password for the superuser account, re-enter to
Confirm Password, and then click OK.

NOTE: User ID and Password are automatically filled with the manufacturer
default superuser account information.

18
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4. Click Get and confirm the User ID and Password for the superuser account, and then
click OK to synchronize the Paper Catalog.

5. Select a Default Paper Size.

6. From the Show Output Options area, select check boxes for each installed finishing
device, and then select the Default Output Option.

7. If the printer is using system software v2.17 or later, select Use Upper Case.

NOTE: Use Upper Case writes files to the marking engine using uppercase
letters. System software later than v2.17 requires this convention.

8. Click Modify, and then Close the Printer Settings.

See Also: Selecting Job and Client ID , Modifying the Paper Catalog .

Selecting Job and Client ID

Custom Print sends files to the print device using a alphanumeric naming convention, or Job
ID, where the first four digits represent the job number, and the last four digits represent the
physical page number. Job ID numbers increment by one each time a job is printed using
Custom Print. The Job ID number can be reset at any time.

When using Custom Print from multiple workstations, adding a unique Client ID for each
workstation eliminates the possibility that a job sent from one workstation, could overwrite
pages in print jobs sent from another where Job ID numbers coincide. A Client ID is consists
of two alphanumeric characters, this identifier replaces the first two digits in the filename for
each page in a print job.

To reset the Job ID

1. Follow the steps to modify printer settings .

2. Click Reset Job ID.

3. Click Modify, and then Close the Printer Settings.

To set a Client ID

1. Follow the steps to modify printer settings .

2. Type a two character alphanumeric sequence in the Client ID field.

IMPORTANT: Although a Client ID can contain numeric characters, this
should be avoided since using a numeric sequence could cause a naming
conflict with other jobs.

3. Click Modify, and then Close the Printer Settings.

Modifying the Paper Catalog

Custom Print keeps a copy of the printer's paper catalog to use for selecting page-level
paper substitutions. The catalog must be synchronized when a printer is first configured, or

20 20
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when changes are made to the printer's paper catalog.

IMPORTANT: Paper catalog names are case sensitive. If printing to multiple
printers define the same paper catalog at each printer to make job templates
portable and prevent printing errors.

To synchronize the paper catalog

1. Follow the steps to modify printer settings .

2. Click Get and confirm the User ID and Password.

3. Click OK to synchronize the Paper Catalog.

4. Click Modify, and then click Close.

Adding Additional Printers

UltraPrint supports an unlimited amount of printers.

To add a printer

1. Follow the steps to modify printer settings .

2. Click Add.

3. Type a Printer Name.

4. Configure the printer .

5. Click Modify, and then Close the Printer Settings.

Selecting a Default Printer

To set a default printer

1. Follow the steps to modify printer settings .

2. Select a printer from the list.

3. Select the Set Default Printer check box.

4. Click Modify, and then Close the Printer Settings.

Renaming a Printer

To rename a printer

1. Follow the steps to modify printer settings .

2. Select a printer from the list.

3. Click Rename.

4. Type the new Printer Name.

5. Close the Printer Settings.

18

18
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Removing a Printer

To remove a printer

1. Follow the steps to modify printer settings .

2. Select a printer from the list.

3. Click Remove.

4. Close the Printer Settings.

18
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3 Working with UltraPrint

3.1 UltraPrint Workspace (overview)

UltraPrint is designed to be easy to use, with a simple workspace divided into two main
sections.

Job List

The job list appears as a tree like structure on the left side of the workspace. The job list
contains two subtrees represented by top-level folders. 

The first and topmost subtree is the Active Queue . This tree appears as a folder titled ‘
Queue’ with a subfolder you name when you create the queue; each queue-based print job
appears chronologically under this subfolder.

The second subtree appears directly under the queue, and represents the path to the
location where your print jobs are stored. Each print job is represented by a subfolder
containing one or more print ready files.

Any folder can be expanded to show it's content, or collapsed to save space, by clicking the 
 or  icon to the left of the folder name, or by simply double-clicking the folder.

To change the print job folder path

1. Click Browse  on the toolbar.

2. Select the drive, folder, or other location where you wish to save print jobs, and the
click OK.

69
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Job Profile and Process Control

The right side of the workspace consists of a series of tabs that each provide a specific set
of information or control. A description of each tab follows.

3.1.1 Job Info

Job Info lists attributes about a selected file or print job. Selections including the location of
temporary files created during printing, the target output device, page setup, and overlays
for background or watermarks are defined here.

Book Attributes

Lists information about the selected object, including size, pages, number of parts (print job),
date and time created (print job) or added (file), and whether the selected file is black &
white or full color.
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Destination

Specifies the directory where bitmap images produced by the rendering engine are created.

NOTE: Destination is initially set to the location specified by the Default
Destination selected in Output File Options .

Printer

Specifies the output device, copy count, and provides access to page setup and printer
properties.

Overlay

Enables and specifies image to be used as a background or watermark on each page.

Printer Output Options

Selects how a print stream is submitted to an output device. Enables color split.

Refreshing Job Attributes

To refresh job attributes

· Right-click a print job or file, and select Refresh from the context menu.

NOTE: Some formats like PostScript (PS) or Portable Document Format (PDF)
may not refresh until they have been printed or opened by Custom Print.

14
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3.1.2 Job Monitor

Job Monitor show jobs that have been submitted to an output device or viewed using the
external viewer.

To resubmit a print job

1. Select the desired print job from the Job Monitor .

2. Click Resend.

Jobs spooling in the Job Monitor may be canceled prior to complete submission to the
selected output device.

To cancel a print job

1. Select the desired print job from the Job Monitor .

2. Click Abort.

To remove all jobs from the job monitor

· From the Job Monitor  tab, click Remove All.

28
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See Also: Working with Files

3.1.3 Cluster Monitor

Cluster Monitor shows the status of printers assigned as a cluster and attached to a queue
for cluster printing.

See Also: Queue-based and Cluster Printing

41
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3.1.4 Web Explorer

Web Explorer is a light-weight web browser used to view job tickets created by Alto Internet
Transaction Server (AITS) for web-based print conversion and submission.
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3.1.5 Image Viewer

Image Viewer lets you preview a selected file without invoking an external application. Files
can be rotated or resized while viewing.

Color percentage is listed to aid in the selection threshold for jobs using color split .64
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3.1.6 Jobs Received

Jobs Received lists and prints job tickets created by Alto Internet Transaction Server (AITS).
Job tickets can be printed from this tab to a specific printer.

To select printer properties and settings

1. Click Page Setup.

2. Select or type Paper, Headers and Footers, Orientation, and Margins.

3. Click Printer to select or change printer properties.

To print current job tickets

· Check the Print Jobs check box.
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3.1.7 UltraDoc Explorer

The UltraDoc Explorer tab provides access to an UltraDoc database. You can copy
individual files or complete print jobs between UltraPrint and the database. When a print job
is copied to the database, the associated job template is automatically stored in the
database so it can be reused when a print jobs is returned to the UltraPrint job list.

NOTE: UltraDoc 'documents' are copied to UltraPrint as files into the currently
selected print job, and UltraDoc 'bundles' are copied as complete print jobs.

 

UltraPrint implements the UltraDoc Explorer interface in its entirety. For more information
see the UltraDoc User Guide.

 

 

To copy a document from the database

1. Select a print job from the Job List, and then click the UltraDoc Explorer tab.

2. Search for the documents you want add to the print job.

3. Select the documents from the search results in the Document List

4. Click Import/Export, and then select Export Page.

To copy a print job from the database

1. Select the UltraDoc Explorer tab.

2. Search for the bundles you want to add to the Job List.
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3. Select the bundle from the search results in the Document List

4. Click Import/Export, and then select Export Book.

To add a document to the database

1. Select a file from in the Job List, and then click the UltraDoc Explorer tab.

2. Click Import/Export, and the select Import Page.

3. Select a document table from the Document Types list.

4. Optionally select Add this document to the selected bundle(s).

5. Click OK to add the document.

To add a print job to the database

1. Select a book from the Job List, and then click the UltraDoc Explorer tab.

2. Click Import/Export, and the select Import Book.

3. Select a bundle table from the Bundle Types list.

4. Optionally select Add this bundle to the selected collection(s).

5. Click OK to add the bundle.

3.2 Creating a Print Job

A print job is simply a container that holds links pointing to original source files. Print jobs
can include one or more files of any supported file type . Since a print job contains links
and not actual files, source documents can be shared among multiple print jobs. Changes to
a source document are reflected in each print job that links to a specific file.

NOTE: When Unique Destination On New Book  is set, TIFF image files are
shared between books; other files linked to multiple print jobs are rendered
individually for each print job.

The final component in each print job is a job template  describing how an individual job
should be printed, and to which output device the print job should be sent. This Extensible
Markup Language (XML) based template is saved as part of each print job. The template is
created automatically during job setup and printing.

To create a print job

1. Click New Book  on the toolbar.

2.  From the Look in list, click the drive, folder, or other location where you want to
create the print job.

3. Type a File name for the print job, and then click Open.

3.2.1 Adding Files

Any number of files including a mixed combination of supported file formats  can be

34
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included in a print job.

To add files to a print job

1. Click Add Page  on the toolbar.

2. From the Look in list, click the drive, folder, or other location that contains the file you
want to add.

3. Select the file(s), and then click Open.

TIP: Add multiple files at once by pressing CTRL or SHIFT while using the
mouse to select files.

See also: Importing Files

Supported File Formats

· Tagged Image File Format (TIFF). A common format for exchanging raster (bitmapped)
images, TIFF images are native to UltraPrint and are minimally processed before sending
to the selected output device.

· Portable Document Format (PDF). A file type created by Adobe for distribution of
documents such that their formatting and design would be preserved and look the same
on any system. PDF files are interpreted using AltoScript and converted to a raster image
before sending to the selected output device.

· PostScript (PS) and Encapsulated PostScript (EPS). PostScript is a page-description
language (PDL) developed by Adobe Systems for printing with laser printers.
Encapsulated PostScript files are based on the PostScript language, and can contain both
vector and bitmap graphics. EPS is supported by most illustration and page-layout
programs. Both formats can be interpreted using either UltraScript or AltoScript and are
converted to a raster image before sending to the selected output device

· Printer Command Language (PCL). A page-description language (PDL) developed by
Hewlett-Packard for early ink-jet printers, PCL is used in many of today's thermal and laser
printers. PCL files are interpreted using UltraScript and converted to a raster image before
sending to the selected output device.

· Page Meta Language (PML). Job Templates  created using Image Arranger. PML files
contain information describing page characteristics like whether the page may be a tab,
marked for 3-hole punching, or marked as a color page. These descriptions may be used
by Custom Print  to automate, or visually select paper substitutions and other output
specific settings.

See Also: Advanced Options , AltoScript Options

3.3 Saving a Print Job

To save a a print job

· Click Save  on the toolbar.

36
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3.4 Importing Files

You can import multiple files to a print job from a directory in a single process. This is handy
for adding files from directories containing large numbers of files. Importing lets you define
both include and exclude patterns using standard file name wild cards.

To import files

1. Select a print job.

2. On the Edit menu, click Import Pages.

–or–

Right-click a print job and select Import Pages.

3. Click the  button to select the drive, folder, or other location that contains the files
you want to add.

4. Select or type Include or Exclude patterns to match specific files based on name,
extension, or a combination of the two.

NOTE: Files appear in the print job sorted ascending based on file name.

See Also: Adding Files , Supported File Formats34 35
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3.5 Removing Files

To remove files

1. Select the page(s) you want to remove

2. On the Edit menu, click Remove Page.

–or–

Right-click a print job and select Remove Page.

NOTE: When you remove a page from a book the original file is not deleted.

3.6 Deleting Print Jobs

To delete a print job

1. Select the print job you want to delete.

–or–

Right-click a print job and select Delete Book.

2. From the Edit menu, click Delete Book.

3. Press Yes to confirm.

3.7 Organizing Print Jobs

Each print job or book that appears in the Job List is simply a list of links to the source files.
Each file link or page appears as a small icon beneath the print job. Reorder files within a
print job by dragging them to a new location; the file is inserted immediately after the
selected position.

Print jobs can be renamed, deleted, or temporarily hidden from view.

3.7.1 Sorting Files

New files are initially added to the end of a print job and can be reordered by selecting a file
and dragging it to a new positions. When source files are titled with consecutive
alphanumeric file names, you can sort the files in a print job based on that name.

NOTE: Files print in the order they appear in a print job.
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To sort files

1. Select the print job you want to sort.

2. From the Edit menu, click Sort Page Ascending or Sort Page Descending.

–or–

Right-click a print job and select Sort Page Ascending or Sort Page Descending.

3.7.2 Renaming Print Jobs
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To rename a print job

1. Select the print job you want to rename.

2. From the Edit menu, click Rename Book.

3. Type the new name, and then click OK.

IMPORTANT: The new name must include the extension 'bml'.

3.7.3 Copying or Moving Files Between Print Jobs

Using the mouse, you can easily copy or move pages between print jobs.

To copy or move pages between print jobs

1. Select the files you want to copy or move. 

2. Do one of the following:

o To copy selected files to another print job , hold down the CTRL key while using the
mouse to drag selected pages to the new location.

o To move selected files to the other document (and remove them from the original
print job), use the mouse to drag selected files to the new location.

NOTE: When Unique Destination On New Book  is set, TIFF image files that are
copied between print jobs are shared by those print jobs. Other files linked to
multiple print jobs are rendered individually for each print job.

See Also: Cut, Copy or Paste Files

3.7.4 Cutting, Copying, or Pasting Files

Cut or copy selected files from a print job.

To cut or copy selected files

To Do this...

Copy the selected file to the clipboard

Click Copy    on the toolbar, or on the
Edit menu, click Copy.

Cut the selected file and save a copy to
the clipboard Click Cut    on the toolbar, or on the

Edit menu, click Copy.

Delete the selected file Press the Delete key, or on the Edit menu,
click Delete.

14
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To paste a file

1. Select a position within a print job.

2. Click Paste  on the toolbar

– or –

On the Edit menu, click Paste.

NOTE: The file is pasted into the print job immediately after the selected
position.

3.7.5 Hiding Print Jobs From View

The print job tree  lists all jobs that exist in the current directory. This list can grow quite
large making it difficult to locate an individual print job. You can 'cut' print jobs from the list
temporarily hiding them from the list.

To hide print jobs in the list

1. Select print jobs from the tree list.

25



Working with UltraPrint 41

© 2008 Alto Imaging Technologies, Inc. All rights reserved.

2. Select Cut  from the toolbar.

Restoring the print job list makes all print jobs in the current directory visible

To restore print jobs to the list

1. Right-click the current directory from the top of the tree list.

2. Select Refresh.

TIP: Restoring the job tree automatically sorts all print jobs by name in
ascending order.

3.8 Viewing and Editing Files

You can view files using either UltraPrint's built-in viewer or the external application
associated with the file format of the selected file. The built-in viewer does not provide any
editing capability, however, most files can be edited using the external application
associated with the file format.

To view a file using the internal viewer

1. Select a file.

2. Select the Image Viewer .

To edit a file

1. Select a file.

2. Select View  from the toolbar.

To view or edit a print job

1. Select a print job.

2. Select View  from the toolbar.

TIP: Selecting a print job or selecting multiple files will cause each file to be
open as an individual document in the external viewer or editor associated with
the file format.

See Also: Image Viewer

3.9 Job Setup and Printing

3.9.1 Page Setup

Page Setup allows you define attributes that are applied to your print job when output. These
attributes include page size and orientation, scaling, headers, footers, numbering, layout,
and other options. Page setup attributes are automatically saved each time you save a print
job , and restored when the document is reopened.

31
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Paper Size, Orientation, and Margins

Select orientation and paper size for printing from a list of standard sizes. Selecting a paper
orientation or size overrides the actual properties of the pages being printed.

Each page is printed inside an area defined by page margins. Margins define the amount of
space between the edge of the page and the page's content. You can enter measurements
for each of the four margins and specify whether content outside those boundaries is
truncated, or scaled to fit  within.

NOTE: If the currently selected printer defines a non-printable area, those
measurements are used as a minimum margin when printing regardless of
measurements you define.

To select paper size, orientation, and margins

1. In the Printer area on the Job Info  tab, click Setup. 

2. Select Paper Size and Orientation.

3. Type the desired Margins.

NOTE: If Fit to Page  is not selected, only that portion of the original page
that fits within the margins will print.

45
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Background Images and Watermarks

You can add a background image to all the pages in a print job. By using a light gray or
screened image a watermark can be created. The image is applied as a transparent overlay
at output.

To add a background image

1. In the Overlay File area on the Job Info  tab, click Browse.

2. Browse to the image file you wish to use, and then click Open.

NOTE: The Background Image File must be TIFF image and the same physical
dimensions as the intended output.

26
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Advanced Page Setup Options

Page Layout and Impositioning

Page Layout lets you select the layout for the entire document. Specialize layouts are
available including 4-page and 8-page signature booklets, n-up configurations, and business
cards.

To select a page layout

1. In the Printer area on the Job Info  tab, click Setup.

2. Select the Layout tab, and do one of the following:

26
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To Do this...

Print 1 image per page (default) · Select 1 up

Print 2 images per page · Click 2 up

· Choose a layout pattern

Print 4 images per page · Click 4 up

· Choose a layout pattern

Print Signature Booklets · Click Booklet

· Choose a layout pattern

· Select Reverse Layout if original
document is in reverse order

Print Business Cards · Click Business Card

· Choose a layout pattern

3. Type the amount of Vertical and Horizontal Spacing (gutters) to be added between
images.

4. Select Border to draw a thin line between each image.

Automatically Detect Paper Size

With automatic page size detection, both actual page size and orientation are sent to the
output device during printing. This allows printing mixed page size or orientation, and
automatic recognition of special pages such as tabs when printing to devices that support
such output.

To select automatic orientation and page size

1. In the Printer area on the Job Info  tab, click Setup.

2. Select the Layout tab, and click Automatic output source selection.

NOTE: When Automatic output source selection is selected, Paper Size and
Orientation  settings are ignored.

Scale a Document to Fit On Different Page Sizes

UltraPrint lets you scale a document for printing to a paper size other that the original
document's page size. This is especially useful when printing to certain page layouts
where the page may need to be scaled prior to printing. For example, printing letter size
originals using a booklet layout , output to Letter size pages in a landscape orientation .

When you scale a document for printing, the changes only occur when the print
job is actually output.

To scale to fit page

1. In the Printer area on the Job Info  tab, click Setup.

26
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2. Select the Layout tab, and click Fit to page.

Headers and Footers

Headers and Footers, including numbering, can be applied on-the-fly at time of output. This
means the application of data like page numbering, does not inhibit the use of a document in
some other context where such data may not be appropriate. Using this method, addition of
content or late-stage revision that changes the number of pages in a document, requires no
change to numbering.

In addition to static text and automatic numbering, date and time can be automatically
inserted. Text can be inserted at any or all three alignment points (left, center, right), and is
placed on the page according to margin values. Header and footer position can alternate on
odd and even pages.
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To add headers and footers

1. In the Printer area on the Job Info  tab, click Setup.

2. Click Advanced, and then click the Headers/Footers tab.

3. Click    next to the Header or Footer box, and select Left, Center, or Right
alignment.

4. Type desired text and use  to insert field variables in the Header or Footer fields
immediately after the alignment variable.

5. Type Top, Bottom, Left, and Right Margin values.

26



UltraPrint User Guide48

© 2008 Alto Imaging Technologies, Inc. All rights reserved.

6. Click Font to select a font, size, color, or style.

7. Click OK.

HEADER/FOOTER  OPTIONS

Category Option Description

Margins Left/Right/
Top/Bottom

Specify header or footer placement as on offset to the 
Left, Right, Top, and Bottom page edge.

Roman Page
Numbering

Start/Stop
at, Counting
From

Select a Start and Stop page to select a range of
pages. Roman numerals are applied sequentially to all
pages in the range. In the Count from box, type or
select a beginning number for the sequence. Setting a
Start and Stop page at 9999 turns Roman Page
Numbering off.

Arabic Page
Numbering

Start/Stop
at, Counting
From

Select a Start and Stop page to select a range of
pages. Arabic numbers are applied sequentially to all
pages in the range. In the Count from box, type or
select a beginning number for the sequence. Setting a
Start and Stop page at 9999 turns Arabic Page
Numbering off.

Settings Group
pages in
sets of

Increment sequence after every N pages where N is the
number entered here

Opaque Create overlay with opaque background obscuring
underlying image area.

Alternate
Left and
Right

Reverse the position of content contained in a header
or footer to the left or right based on whether the page
is odd or even. Use this to force headers or footers
(especially page numbers) to the outside margin when
the document is intended for two-sided (short-edge)
output. This has no effect on center aligned headers or
footers.

Skip on
pages

Pages marked as Tabs, Covers, and/or TOC are not
numbered.

Skip page
count

Excludes pages marked as Tabs, Covers, and/or TOC
from the page count used to number pages.

HEADER/FOOTER  VARIABLES

Variable Type Description

&P00 Field Page Number*

&N Field Total Page Number



Working with UltraPrint 49

© 2008 Alto Imaging Technologies, Inc. All rights reserved.

Variable Type Description

&D Field Current Date

&T Field Current Time

&& Field Literal '&'

&L Format Left Align

&C Format Center

&R Format Right Align

* Page Numbering includes a  2-digit suffix indicating the Page Number Padding, or
width. Variable-width numbering is "&P00".

TIP: Format and Field variable can be entered using the keyboard.

Numbering

Numbering can be applied as a header or footer field variable, or by using sequential
numbering overlays . Generally, numbering using a header or footer is best for applying
page numbers, simple sequential numbering, or Bates stamping. Sequential numbering
overlays are better choice for more sophisticated applications like serialized form or N-up
ticket layouts, multi-part document page numbering, or more complex Bates stamping. The
table below compares the capabilities of both methods.

TIP: Use a combination of both numbering methods to meet the
requirements of complex numbering applications.

66
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Description Header/Footer Sequential Numbering
Overlays

Variable-width numbering Yes Yes

Fixed-width numbering Yes Yes

Adjustable increment No Yes

Roman numerals Yes No

Arabic numbers Yes Yes

Automatically skip tabs Yes No

Alternate odd/even pages Yes No

Global counter Yes No

Multiple regions 2 Unlimited

Number of copies printed based
on number range 

No Yes

Format String Examples

Format String Output

Page &P00 Page 1

Page &P03 Page 001

Page &P00 of &N Page 1 of ##

Page &P03 of &N Page 001 of ##

CASE "ABC, Inc" - PAGE
#ABC-&P05

CASE "ABC, Inc." - PAGE #ABC-00001



Working with UltraPrint 51

© 2008 Alto Imaging Technologies, Inc. All rights reserved.

Covers and Table of Contents

UltraPrint makes it easy for you to create a cover and table of contents for your publication.
A cover can be created using either the print job name or your own custom text. Table of
contents entries are created using the file name for each file contained in your print job. You
can select font, positioning, and even add a company logo or other image to a cover.

To create a cover

1. In the Printer area on the Job Info  tab, click Setup.

2. Click Advanced, and then click the Cover tab.

3. Select Create Cover Page at Print Time.

26



UltraPrint User Guide52

© 2008 Alto Imaging Technologies, Inc. All rights reserved.

4. Type Left, Top, Right, and Bottom Position to define where the text should be
placed.

5. Click Font to select a font, size, color, and style.

6. Do one of the following:

To Do this...

Use the print job name as the title Select Use Book Name as Cover Title

Use custom text as the title Type the title in Cover Title Text, and then
click Add

TIP: Add multiple custom text entries each with their own positioning and font
characteristics to create professional looking covers.

To add a background image

· Click File and browse to the Background Image File you wish to use, and then click
Open.

NOTE: The Background Image File must be a TIFF image and be the same
physical dimensions as the target page.

COVER  OPTIONS

Category Option Description

Enable Create
Cover Page
at Print
Time

Enables cover page.

Cover Title
Information

Use Book
Name as
Cover Title

Create cover title text using book name

Cover Title
Text

Define custom title text. Type text in the entry box and
then click Add.

· To edit an existing line: select the entry, modify the
text and then click Update.

· To reorder an existing line: select the entry, and then
click Up or Down.

· To delete an existing line: select an entry and then
click Delete.

· To delete all lines: click Delete All.

Position,
Size

Left, Top,
Right,
Bottom

Position as measured from the Top and Left edge of the
page
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Category Option Description

Background Image File Background image overlayed on cover page.

To create a table of contents

1. In the Printer area on the Job Info  tab, click Setup..

2. Click Advanced, and then click the TOC tab.

3. Select Create Table of Contents at Print Time.

4. Type the TOC Frame Size and Left, Right, Top, Bottom Margins to define where

26
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the text should be placed.

5. Click Font to select a font, size, color, and style.

TOC OPTIONS

Category Option Description

Enable Create
Cover Page
at Print
Time

Enables Table of Contents page.

TOC Frame
Size

Frame
Width/

Frame
Height

Size of page.

TOC
Margins
(inches)

Left/Right/
Top/Bottom

Amount of space between the edge of the page and the
page's content.

3.9.2 Printing

UltraPrint provides many flexible printing options to help you create, set-up, and submit print
jobs ranging from simple jobs made from a single file, to large jobs consisting of multiple
files with complex insertions, page exceptions, and other settings. Print jobs may include
dissimilar file formats of varying resolution, color space, or number of pages.

You can submit print jobs in their entirety, or select and print a subset of files from any print
job. UltraPrint can submit a print job as multiple parts to prevent overloading a print spooler,
or to simulate subset operations like finishing or chapters on output devices that do not offer
such functions.

UltraPrint can also function as a print file downloader. Files expressed using a page
description language (PDL) like PostScript (PS) or  Portable Document Format (PDF) can
be sent as a raw print stream  to output devices with built in Raster Image Processors
(RIP) capable of interpreting such formats.

There are several ways to select print settings and submit a print job to an output device.
Following is a summary of the advantages and disadvantages associated with each method.

Printer Driver

You can use the printer driver provided by the manufacturer of the output device and select
print settings using the interface provided by the driver.

Advantages

· Typically offers most complete set of functionality for a specific device.

Disadvantages

· May be difficult to use.

64



Working with UltraPrint 55

© 2008 Alto Imaging Technologies, Inc. All rights reserved.

· Selecting standard options like collating or two-sided printing may require you to go
though several layers of menus or tabs to access.

· Simple tasks like selecting page exceptions may require manually typing page
numbers or ranges.

Custom Print Common

You can use Custom Print Common as a "friendlier" interface to the printer driver provided
by the manufacturer of the output device. Custom Print Common maps settings you select,
to driver specific functionality, and then prints to the output device through the printer driver.

Advantages

· Easy to use.

· Standard options like collating or two-sided printing available in single interface.

· Point-and-click method for selecting page exceptions and adding inserts.

· Provides a standard device interface across devices independent of manufacturer or
type

Disadvantages

· Some device functionality may not be available directly through this interface, however
the printer driver is accessible from Custom Print Common allowing you to select driver
specific settings.

Custom Print Digimaster 9110

Custom Print is an advanced printing interface for output devices based on the Heidelberg
Digimaster 9110. Image data is written directly to the System Control Subsystem (SCS). A
small set of Kodak Graphics Language (KGL) headers are created based on print settings
and selection and passed to the page definition language (pdl) interpreter.

Advantages

· Complete set of functionality for the Kodak/Heidelberg DigiMaster 9110/E125/E150
printers.

· Uses direct TIFF printing to maximize output speed.

· Standard options like collating or two-sided printing, and advanced options like covers,
or padded output are available in single interface.

· Easy to use, point-and-click method for selecting page exceptions, adding inserts and
programming the most complex print jobs.

Disadvantages

· Only available for the Kodak/Heidelberg DigiMaster 9110/E125/E150 printers.
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Job Templates

Job templates are created for each print job as well as for each individual file in a print job.
When you select printer properties and settings , or submit a print job  for output, these
templates are updated to reflect the changes you made. The template describes the page
setup  selections and settings chosen from the printer driver for the selected output
device, as well as information describing individual page characteristics like whether the
page may be a tab, marked for 3-hole punching, or marked as a color page.

Job templates describing job level settings are stored as Book Meta Language (BML) files,
while settings specific to an individual file are stored as Page Meta Language (PML) files.
Both formats are Extensible Markup Language (XML) based.

PML files may be added  or imported  directly to a print job resulting in the page
settings (exclusive of of printer driver settings) contained in the PML being inherited for that
file. This means that pages containing marks (color, tab, 3-hole, etc.) made using Image
Arranger are marked accordingly and may be easily selected for to set page-level properties
when using a Custom Print  interface for job submission.

See Also: Adding Files , Importing Files , Supported File Formats

Submitting a Print Job

To submit a print job to an output device

1. Select a Printer from the list on the Job Info  tab.

NOTE: Selecting the right print driver is important regardless of the method you
ultimately choose to provide printing services. You should select a PostScript
printer driver that matches the intended output device, even when using a 
Custom Print  interface.

2. Select Page Setup  options.

3. In the Printer area on the Job Info  tab, type or select Copy Count.

4. Do one of the following:

To Do this...

Print using a print driver 1.Select Printer Properties and Settings .

2.Select Print  from the toolbar.

Print using Custom Print Common 1.Select Printer Properties and Settings .

2.Select Custom Print Common   from

the toolbar.

Print using Custom Print Ricoh RPCS · Select Custom Print Ricoh RPCS  

from the toolbar.

Print using Custom Print Digimaster
9110

· Select Custom Print Digimaster 9110

 from the toolbar.
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Selecting Printer Properties and Settings

Before submitting a print job, select the properties and settings to determine the way
documents are printed. Options vary from printer to printer, but most printers allow the
following:

· Changing the layout orientation of a page by choosing portrait or landscape.

· Changing the number of copies that are printed. 

· Choosing to print on both the front and back of the paper. 

· Selecting the tray to print from, such as the manual feed tray or an envelope feeder. 

· Choosing the material to print on, whether it is card stock, transparency, labels, and so
on.

TIP: See the documentation for your output device for more information.

To select printer properties and settings

1. In the Printer area on the Job Info  tab, select Setup.

2. From Page Setup  select Printer, and then click Properties.

3. Choose the desired properties and settings.

NOTE: Printer properties and settings for the selected printer affect output
when you submit a print job using the print driver directly (except when 
submitting raw print streams ), or when using the Custom Print Common
interface.

Using Custom Print

Custom Print is an advanced printing interface that simplifies the selection of print options
and settings for even the most advanced print job. Settings can be applied quickly to entire
documents, or selected pages within a document by using the mouse to select pages in the
page selector and then specifying the desired options. Page exceptions can be easily made
without requiring you to type confusing and error-prone page range specifiers. Print settings,
including driver specific options are saved as a individual job templates for reuse during
subsequent submission of a print job. Three Custom Print interfaces are available:

· Custom Print Common. This interface is available for all printers. Selections made
using this interface are converted to driver specific calls and submitted to the output
device using the selected printer driver. Some device options may not be directly
available using this method, but may be set using the printer driver's properties from
the Custom Print Common advanced printing interface.

· Custom Print Ricoh RPCS. This interface is available for output devices that use the
Ricoh Refined Printing Command Stream (RPCS) driver. 

· Custom Print DigiMaster 9110. This interface is available for output devices based
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on the Kodak/Heidelberg DigiMaster 9110/E125/E150 printers.  Pages are sent directly
to the marking engine, accompanied by  printing instructions specific to the device. No
processing by the RIP is necessary, and printing throughput is maximized.
Point-and-click selections for paper substitution, unlimited sub-set finishing, and
advanced options like padding make Custom Print a powerful printing tool.

Using Custom Print is generally the same regardless of the output device. Follow the steps
below to use the Custom Print interface. Refer to the following pages for specific information
about each output device.

To use Custom Print

1. Select a print job, file, or range of files.

2. Click a Custom Print  device on the toolbar.

3. Select global Print Setings.

4. Select pages and choose Page Level Settings.

5. Insert Blank Pages if desired.

6. Do one of the following:

o Click OK to save settings.

o Click Print to save settings and print.

NOTE: Select global Print Settings first to avoid overwriting Page Level Settings.

Mapping Catalog Media to Printer Media

Since media definitions vary among output devices, dissimilar types and descriptions must
be mapped to media available on the target device prior to output using a Custom Print
interface. For example, a medium or form called "8 1/2x11 Tab" on one device may be
called simply "Tab" on another.

If Custom Print cannot determine how to match such media, you will be prompted to map
existing definitions to media available on the selected output device. This is often necessary
when using Custom Print for the first time after selecting a new output device for an existing
print job.
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To map catalog media to printer media

1. Select an undefined medium on the left side.

2. Select a an available definition on the right side.

3. Click Map Media.

NOTE: Media that cannot be mapped to an available type on the target device
is automatically mapped to the default media as defined by the printer driver

To remove or change media mappings

1. Click Map  from Custom Print.

2. Under Mapped Media, select a mapping definition.



UltraPrint User Guide60

© 2008 Alto Imaging Technologies, Inc. All rights reserved.

3. Click Remove.

4. If desired, follow the steps in the previous section to create a new mapping.

Custom Print Common
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Custom Print Ricoh RPCS

Custom Print Digimaster

Custom Print provides advanced printing interface to the Canon iR110 or Heidelberg
Digimaster 9110 marking engine. With Custom Print, and through the use of Kodak
Graphics Language (KGL) headers, image data can be written directly to the System Control
Subsystem (SCS), bypassing page definition language (PDL) interpretation. The KGL
header alone is quickly interpreted, and makes reference to the image files that are then
passed directly to the marking engine.
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Submitting Individual Files

In addition to printing complete print jobs, you can submit individual files separately from
their containing print job. Each file is submitted using the page setup selections of the
containing print job.

To submit individual files

1. Select one or more files.

2. Do one of the following:

To Do this...

Print using a print driver 1.Select Printer Properties and Settings .

2.Select Print  from the toolbar.

Print using Custom Print Common 1.Select Printer Properties and Settings .

2.Select Custom Print Common   from

the toolbar.

Print using Custom Print Ricoh RPCS · Select Custom Print Ricoh RPCS  

from the toolbar.

Print using Custom Print Digimaster
9110

· Select Custom Print Digimaster 9110

 from the toolbar.
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NOTE: Custom Print is not available when selecting files from multiple print
jobs.

Submitting Multi Part Print Streams

Print jobs made up of multiple files are normally sent to an output device as a single print
stream. UltraPrint can send a print job as multiple print streams by sending each file as a
single print job. This method offers the following advantages:

· Large print jobs are submitted in "chunks" effectively throttling communication to the
output device. This may reduce bottlenecks or storage overflow at the destination.
Some jobs might otherwise be impossible to print.

· Copy count can be set for each individual file.

· Subset finishing can be simulated on devices that do not offer such functionality
through the device driver. For example, if a stapling feature is selected for a file within
a print job, but not selected for the containing print job, only a portion of that print job
will be stapled.

· Page setup options can be applied individually to each file independently of the
containing print job. You can select different headers/footers to create sub-section
page numbering, choose differing layouts or orientation, or create separate overlays
for each section.

To submit a multi-part print stream

1. Select printer properties and settings  and copy count  independently for each
file.

2. In the Printer Output Options area on the Job Info  tab, select Multi Part Print
Job.

3. Select Print  from the toolbar.

Setting Copy Count for Part

Copy count can be set for any file independently of the containing print job, or other files
within a print job. This count is used only when submitting complete print jobs or individual
files with Mutli Part Print Job  selected.

To set copy count

1. Select one or more files.

2. Type or select Copy count.

3. Click Set PML Copies.
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Resetting Print Job Options

You can restore print job properties and settings across each individual file. Print job
properties and settings including copy count defined for the containing print job are applied
to each file in the print job.

To reset print job options

1. Select the containing print job.

2. Click BML --> PML, and then click Yes.

Submitting Raw Print Streams

There are times when it may be desirable to send raw Page Description Language (PDL)
data to an output device. For example, a large full-color PostScript or PDF document that
requires no change or other manipulation may be sent directly to a full-color output device
capable of rendering such files. In this scenario, UltraPrint functions as a print file
downloader.

To submit a raw print stream

1. In the Printer Output Options area on the Job Info  tab, select Raw.

2. Select Print  from the toolbar.

Managing Current Print Jobs

Print jobs submitted during the current UltraPrint session flow through and remain available
in a processed state. Use the Job Monitor  to cancel spooling, resubmit a print job without
re-rendering or spooling, or remove all processed print jobs.

Working with Full Color

UltraPrint supports output to full color output devices. Full color Tagged Image File Format
(TIFF) images are always rendered as full color when submitted to a full color output device.
Print ready formats like PostScript (PS) and Portable Document Format (PDF) can be sent
to the viewer or to an output device as black and white (default) or full color.

To enable full color output

· In the Attributes area on the Info tab, select Render as RGB.

Separating B&W and Full Color Output

When working with print jobs containing both black and white, and full color documents,
UltraPrint can split the print job between two printers sending black and white pages to a 
Kodak/Heidelberg DigiMaster 9110/E125/E150 printer, and pages containing color to a full
color output device.

UltraPrint lets you specify a color 'threshold' to filter pages with minimal color data. This
helps to reduce printing costs by diverting pages with little color data to the monochrome
output device.

The Image Viewer  tab lists the Percent Color for the page currently being viewed. After

26

28

31



Working with UltraPrint 65

© 2008 Alto Imaging Technologies, Inc. All rights reserved.

sampling several representative pages in a print job, you can determine the color threshold
for color split.

To print using color split

1. In the Printer Output Options area on the Job Info tab, select the Color Split check
box.

2. Click  next to the Color Split check box.

3. Select a Color Printer, and then click  to select printer properties and options .

4. Select Color Split options.

Color Split Options

Specify options that determine whether a page is sent to the monochrome or full-color
printer.

Category Option Description

Color
Detection
Level

Black
Luminosity
Level

Adjust Luminosity Level to filter pages with subtle
background color.

White
Luminosity
Level

Color
Threshold

Percent
Color

Sets percentage of total pixels on page that must
contain color before a page will be sent to the color
printer.
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NOTE: Use the Image Viewer  to determine the Percent Color for any given
page.

3.10 Advanced Operation

3.10.1 Merging Variable Data

Use UltraPrint to merge variable data when you want to print a large number of documents
that include some unique information. For example, you can use a text overlay to create a
product announcement to send to your customers. The customer names and addresses are
stored in a data source that is overlayed on each letter in a specified region. One set of
documents in output for each record in the data source. The body of the document is the
same, but the name and address are different for each customer. 

Overlays can also be used to apply variable numbering, or ‘annotation’, using a format
pattern you define. The pattern specifies the beginning and end of the sequence, the width
of the numbering field (padded with zeros), and the amount to increment the sequence with
each successive iteration. Annotation can be used to generate unique form numbers, or
sequences of any type.

Preparing Data Sources for Overlay

You can use any text file that has data fields separated (or delimited) by a character like a
comma, grouped into data records separated by a second character. UltraPrint supports end
of line, tab, semi-colon, colon, comma, and vertical bar as delimiters. The character selected
to delimit data fields must be different than the character selected to delimit data records.

Many 3rd party applications including Microsoft Excel, and most database applications can
export data to a delimited format like Comma Separated Values (CSV) shown in the
example below.

ATTICUS FINCH,2200 SUMMIT AVE,EUGENE OR 97403

RED FOREMAN,1700 MILLRACE DR,EUGENE OR 97403

KELLY BUNDY,1905 AGATE ST,EUGENE OR 97403

JOHN GALT,1943 AGATE ST,EUGENE OR 97403

DIRK PITT,1943 1/2 AGATE ST,EUGENE OR 97403

JACK RYAN,1961 AGATE ST,EUGENE OR 97403

GEORGE CASTANZA,1800 COLUMBIA ST,EUGENE OR

BUFFY SUMMERS,1804 COLUMBIA ST,EUGENE OR

JOHN DORIAN,1830 COLUMBIA ST,EUGENE OR

JACK SPARROW,1832 COLUMBIA ST,EUGENE OR

Defining Text Overlays

After preparing a data source for overlay, define the overlay position based on
measurements from the top and left edge of the page, and select the font, alignment, and
other overlay settings.
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To create a text overlay

1. Select Text File and type a File Name, or browse to locate the file containing variable
data.

2. Select Field and Record delimiters from each list to specify the character used to
separate fields.

3. Click More to select a Font.

4. Under Position, type Left, Top, Right, and Bottom measurements to define the
region where the data will be placed on the page.

NOTE: Position is defined as measurements in inches from the top or left edge
of the page.

5. Select Alignment to specify how the text should be placed within the region.

6. Type or select the page where the overlay should Start and Stop.

7. Select other Overlay Settings  as desired.68
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Overlay Settings

Several options are available to change the way overlay records are applied to the page,
mapped to multi-file print job, or submitted to the output device. The following list describes
the settings.

Category Option Description

Modes Clip to Box Truncates data that does not fit within the region
defined by Position settings.

Opaque Create overlay with opaque background obscuring
underlying image area.

1-to-1
Association

Sequentially matches each record in the data source to
a file in the print job.

Single Print
Job

Submits the entire print job as a single print stream to
the output device.

Generating Numeric Sequences

You can generate numeric sequences for numbering documents like invoices and tickets.
The sequence can be incremented by any whole number, and formatted to a fixed width.

To generate a numeric sequence

1. Select Annotation, and then click Annotation Sequence Generator .

2. Type or select Start and End to define beginning and ending sequence numbers.

3. Type of select the amount to Increment each number in the sequence.

4. Type or select the Padding width of the sequence field.

NOTE: The sequence is prefixed with zeros when necessary to match the
Padding width.

5. Select other Overlay Settings  as desired.68
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3.10.2 Queue-based and Cluster Printing

UltraPrint supports the creation of a single ‘Active Queue’. This queue is made available
through one or more shared Window printers using the Alto TIFF driver, enabling remote
printing from any network accessible device that can submit output to such a printer. This
makes the queue an ideal method for introducing documents into an UltraPrint workflow
directly from the native application, eliminating changes in pagination, or the need for font
substitution that sometimes occur during the rendering process.

The Active Queue can also have up to four printers attached and can serve as a rule-based
printing cluster.

Configuring the Active Queue

Before you begin, make sure you have...

· A shared folder to serve as the queue.

IMPORTANT:  The share name must match the name you assign to the
queue in later steps.

The directory must be completely empty. Even the existence of hidden,
system files like Thumbs.db or

Desktop.ini will cause the creation process to fail.
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To create a queue

1. Click Preferences  on
the toolbar.

2. Select the Active Queue
tab.

3. Click New and type a
queue Name.

4. Type the path to the 
Location of the folder you
previously shared.

5. Click OK.

6. Set the queue state .

Selecting Queue Properites and Settings

Select up to four printers for use by the Active Queue. Page Setup options are set
individually for each printer. When print jobs are released from the queue, they print based
on queue rules beginning with the first printer in the list.

NOTE: These steps are not required if you are only using the Active Queue to
receive print jobs in the Hold state.

To add a printer

1. On the File menu, click Preferences, and then click the Active Queue tab.
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2. Click Properties, and then click Add.

3. Select a printer for the list, and then click OK.

To change the printer priority

1. On the File menu, click Preferences, and then click the Active Queue tab.

2. Click Properties.

3. Select a printer, and then click Up or Down to move the printer.

To remove a printer

1. On the File menu, click Preferences, and then click the Active Queue tab.

2. Click Properties.

3. Select a printer, and then click Remove.

To modify page setup

1. On the File menu, click Preferences, and then click the Active Queue tab.

2. Click Properties.

3. Select a printer, and then click Page Setup.

4. Select Page Setup  settings and options.

Setting Queue Rules

When submitting output to a printing cluster, UltraPrint uses a set of rules to determine how
print jobs are distributed among each printer. For each rule there is a Distribution Level and
a corresponding Threshold. The following table describes each rule set.
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Distribution Level Threshold

Copy Number of copies requested

Page Number of pages in print job

Record Number of records for text overlay

Document Number of documents

Document Per Job Number of documents per job

Some rules may be further controlled based on a threshold levels and/or number of copies.

Setting the Queue State

The Active Queue supports three distinct states:

· Start. Jobs are immediately passed to the printer(s) attached to the queue.

· Hold. Jobs are held and appear in the queue. These jobs may be copied or moved
from the queue to a print job, or released to the printer(s) attached to the queue by
changing the queue state to Start.

· Stop. Jobs are not accepted.
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To select the queue state

· Right-click the queue and select Start, Hold, or Stop.

Configuring the Printer Driver

Use the Alto TIFF Driver to print to the Active Queue. Multiple printer drivers can be used to
print into the queue. Print jobs appear in the queue with a numeric sequence and the printer
name prefixed to the filename.

To add the queue printer driver

1. Click Start , and then click Printers and Faxes.

2. Under Printer Tasks, click Add a printer, and then click Next to start the wizard
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3. Click Local printer, and clear the Automatically detect and install my Plug and
Play printer check box.

4. Click Create a new port, and then click Alto Port.

5. Type the port name:

UPSQ(Inbox)

NOTE: Replace 'Inbox' with the name of the Active Queue you created.

6. Follow the directions to Install the Printer Software; use the Have Disk option to
locate the Alto TIFF driver files.

7. Enter a Printer Name.

NOTE: The printer name you assign is the name that will prefix print jobs in the
queue.

8. Select Default Printer and Printer Sharing options.

9. Print a Test Page if desired, and Finish the Add Printer Wizard.

To configure the printer

1. Right click the printer, and then click Properties.

2. Click the Advanced tab, and clear the Enable advanced printing features check
box.

3. Select Printing Preferences and Printing Defaults as desired.

3.10.3 Other Printing Formats

Working With RDO Files

Raster Document Objects (RDO) are a proprietary printing format created using Xerox
DigiPath's Document Scan and Make Ready application. This format often requires the user
to continue operation and maintenance of expensive legacy Xerox duplicating equipment.
UltraPrint provides an alternative for continued use of existing RDOs and output to almost
any print device.

RDO documents are made up of several different components including Documents and
Pages:

· Documents serve as a container for all other components and can be identified by the
file extension *.rdo.

· Pages can be made up of one or more Tagged Image File Format (TIFF) images, and
may contain other file formats like PostScript (PS) and Portable Document Format
(PDF). When combined, or overlayed, these files make up the content of a single
page.
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UltraPrint imports RDO documents produced using Xerox DigiPath version 3.x or earlier
(images only for documents created using version 3.x). After parsing the file and reading the
TIFF pages contained in the document, UltraPrint creates a print job using name from the
original RDO.

Import options include:

· Image Storage Control. Choose whether individual TIFF images are merged into a
single multi-image file or left as single images.  Multi-image TIFF file can be created
for each section (tag-specified grouping of pages), named using the original RDO tag
label.

· Merge Overlay Control imports pages without merging overlays, significantly reducing
import time.

· Map File Import creates a map file using a paper catalog imported from a 
Kodak/Heidelberg DigiMaster 9110/E125/E150.

Page exceptions (different stocks for selected pages) in the RDO document are matched to
the paper definitions in a map file  and an Extensible Markup Language (XML) job
template is created. The XML can be used as the basis for creating a Custom Print  job
template   for the Kodak/Heidelberg DigiMaster 9110/E125/E150 printer, mirroring page
exceptions and other specific print settings found in the original RDO.

See Also: RDO Import Options , Custom Print DigiMaster 9110 , Using Custom Print
Digimaster

Importing RDO Files

There are two components necessary to import an RDO file, the RDO file itself, and a
matching folder with the extension 'con', that contains the actual images, overlays, and other
items that make up the whole document.

If you are importing an RDO named '2JJ3', the following example shows how the
components might be appear in a directory listing:

12/07/2007 02:30 PM <DIR> .
12/07/2007 02:30 PM <DIR> .
12/07/2007 02:30 PM <DIR> 2JJ3.con
12/07/2007 02:30 PM 234,086 2JJ3.rdo

To import an RDO file

1. Click Import RDO  on the toolbar

– or –

On the File menu, point to Import File, and then click Paste.

2. Browse to locate the RDO file, and then click Open.
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RDO Import Options

Several options are available to control how RDO files are treated during the import process.
Some controls affect the quality or speed of the import process, others determine how
images and overlays are merged.

Category Option Description

Image
Storage

Single
Image Per
File

Each page in the RDO is imported as a single image
TIFF file

Multi Image
Per File

Pages are merged to create a single, multi-image TIFF.

Import
images
using
original
RDO Tag
Labels

A multi-image TIFF file is created for each section
(tag-specified grouping of pages). The resulting file is
named using the original RDO tag label.

Reduction
Mode

Halftone Imports images at the highest possible quality. Import
speed is slower.

Color on
Color

Imports images at lower quality. Import speed is
faster.

Image
Import
Conditions

Merge
Document
with
Overlays

Some pages can be comprised of more than one image
(overlay). Setting this option will cause these overlays to
be merged into a single image. Pages may be scaled or
other processing may occur based on information
contained in the RDO document file. While this will give
you the most accurate representation of the RDO
document, import speed will be slower.

Skip
Document
Rendering if
No Overlays

Prevents UltraPrint from re-rendering base images if
there are no overlays for a page.

Import
Documents
Only

Only the main image in a page comprised of multiple
images will be imported, overlay images are discarded.
No other processing will occur. Import speed is fastest.

Import
Documents
and
Overlays
Separately

All pages including overlays will be imported, however,
overlays are not merged, but are imported as separate
images.

Other
Options

Display
warnings
during RDO
Import

Select this option to display a warning message for
each image that cannot be merged or other messages
associated with the import process.
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Category Option Description

Use the XML
data to
build the
Default
DM9110
Template

During RDO document import, an XML file is created
containing RDO document information like page
exceptions. Select this option to use the XML file as a
basis for creating a Custom Print template for the
Kodak/Heidelberg DigiMaster 9110/E125/E150 printers.

Specify RDO
Import
Directory

Select this option to cause UltraPrint to import an
entire directory of RDO documents. UltraPrint will
traverse all sub-directories in the specified directory.

To change GGX options

1. Click Preferences  on the toolbar.

2. Select the RDO Import Options tab.

TIP: Turn off Display warnings during RDO Import to automate the import
process when multiple RDO files are selected for import or when the Specify
RDO Import Directory option is selected.

See Also: Working With RDO Files

Importing and Editing the Map File

A map file contains information about paper types contained in the paper catalog of a
Kodak/Heidelberg DigiMaster 9110/E125/E150 printer.

During the import process, page exceptions found in an RDO are mapped to media
descriptions found in the map file. An Extensible Markup Language (XML) job ticket is
written and used to create a job template , mirroring page exceptions and other specific
print settings found in the original RDO.

Page exceptions that do not match an entry in the map file are declared UNDEFINED and
added to the end of the map file. Undefined page exceptions list the original exception
attributes such as page size, stock, weight, etc. and can be resolved by editing the map file
matching the undefined exception to any media listed in the file.

To import the map file

1. Click the Import Map File button.

2. From the Look in list, select the drive, folder, or Internet location that contains the file
you want to open.

3. Select the file, and then click Open.

TIP: Paper catalogs are named using the following convention:
def_media_catalog.mc[1..9]. Paper catalogs can be found in C:\Program

Files\Alto Imaging Common\Templates\9110\ after Custom Print  has

been configured.
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Resolving Undefined Page Exceptions

Unless resolved, undefined page exceptions are printed using the default media or paper.
Resolving undefined page exceptions lets you match the original page exception to an
existing media description available in the paper catalog.

To edit the map file

1. Click the Edit Mapping File button. The map file opens in the default editor.

2. Change the name UNDEFINED to an existing media name listed in the map file.

TIP: Deleting a Custom Print template will cause the RDO page exceptions
to be 're-mapped' to paper types found in the map file. This is handy if you
edit the map file and want to refresh the Custom Print template.
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3.11 Keyboard Shortcuts

Open Book CTRL+O

Save Book CTRL+S

Print CTRL+P

Cut CTRL+X

Copy CTRL+C

Paste CTRL+V

Delete DEL

Add Pages CTRL+A

Remove Pages CTRL+R or DEL
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4 Getting Help

There are many sources of support available to ensure your experience with UltraPrint is an
enjoyable one. Here are several ways to obtain the help you need.

Microsoft Windows Documentation

Refer to the documentation provided by the computer manufacturer or with the operating
system.

Scanner Documentation

Your scanner documentation provides complete information about the hardware.

Alto Imaging Technologies Resellers

Your local reseller (the one that helped you choose your UltraWare system) may be best
equipped to help you. Your vendor has specially trained staff available to answer questions.

Online

· Web site: http://www.altoimaging.com/

· Knowledge Base: http://www.altoimaging.com/kb

· Support Request: 
http://www.altoimaging.com/AltoWeb/ProductSupport/Support/Support.html

Customer Service

Monday through Friday, 8:00 am to 5:00 pm, Central Standard Time. You can reach us by
telephone at (251) 343-9339 (US)

If you do call for assistance, have the following information ready so our Customer Support
Representatives can help you more quickly.

· Your phone number, fax number, email and shipping addresses

· A description of the problem

· The version of the Alto Imaging application you're using (from the Help menu choose
the About command)

· The computer model, scanner, printer and any firmware version information you have

· The type and version of operating system you're using

· The amount of memory installed on your PC and printer

http://www.altoimaging.com/
http://www.altoimaging.com/kb
http://www.altoimaging.com/AltoWeb/ProductSupport/Support/Support.html
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